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Welcome to BigAnt IM

If you're the admin for BigAnt Messenger in your organization, you're in the right place.
When you're ready to get going with BigAnt server administration, start with Launch
BigAnt server console. If you're new to BigAnt Messenger and want to learn more, read

on.

Overview of BigAnt Messenger

This program is an enterprise collaboration and instant messaging system. BigAnt is not
only a chat app, but a management idea. Enterprises can break through the constraints
of office spaces through function by BigAnt, shorten the distance of management, build
team with clear responsibilities. BigAnt enables businesses to leverage the power of
collaboration and communication services in a more secure, efficient, and well man-

ageable way!

BigAnt server requirements

Hardware and software requirements for server

Network requirements:

LAN environment;

Internet environment (if required);

Static IP address under TCP/IP protocol, or dynamic IP with DDNS - dynamic domain
name;

Hardware requirements:

10G free disk space or more

4G RAM or above

For company with 1000+ staff, it is recommended to use a dedicated server; Hard disk:

80G; RAM: 8G; CPU: 2.40Ghz or better profile;
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Software requirements:
Windows 10/7/XP

Windows Server 2016/2012
64-bit based operating system

No previous version BigAnt installed (Or clearly removed)

Clearly remove BigAnt server console, if it was previously installed

This is important, as the previously installed BigAnt services may still running and
prevent a fresh install

Open your system Services, list and sort services by name

Find all prefix with “Ant” or “Up”, stop those services.

Uninstall BigAnt Console from your Programs and Features, or using unist.exe in the
installation directory to uninstall BigAnt Console.

Remove the entire installation folder.

Make sure your client version matches server version

As you were running BigAnt server console version 5.2, please make sure the BigAnt
client is version 5.2

You may confirm the software version by checking installed program property, or run it
and click “Main menu/About “to find out version information.

In case you are running incompatible BigAnt client/Server, your client may have

problems showing contact list, and some other issues.
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Install BigAnt Server Console

Download BigAnt program, extract files from the zip file, double click

BigAntServer5.5.10_Setup_64bit.exe to install BigAnt Server (IM Console)

& BigAntClient5.5.14 exe
| ® BigAntServer5.5.10_Setup_64bit.exe

Choose the location to install BigAnt Server

Click Install to continue

BigAnt Software
BigAnt Server

Install

M | accept tne license agreement a Destination Location ¥

BigAnt Software

A brand new BigAnt 5

Su s, Linux server,

reliable and faster

Installing, please wait...

BigAnt Software

Installation Complete !

Start

Click ‘Start’ button when the installation is complete
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Setup your Database and company

Click the button Next and begin to check the system environment

BigAnt Server Setup 5.0.15

o Select DB ENV Test Create DB Setup Complete

Please select database type for BigAnt

Embedded database

Choose another database ¥

If you need to connect to your own database MySQL, or SQL database, please click
“choose another database”, then you will find more options on database, by default, it
will copy embedded database and create it on your BigAnt server, please click next to
continue.

Checklist of system environment

If all items are shown with green check, then your system is on good condition, and you
can continue with system setup.

If error symbol with red cross, there must be something wrong with your installation or
your system. In some cases, it was cause of remaining files or services of pervious
install, please uninstall the IM Console, and try again with a fresh re-install of the
program. If the problem continues, please capture the screen and send us to get
technical support. Some of items such as AD/LDAP environment are not necessary, and

you may ignore such warning and continue with BigAnt server install.

BigAnt Server Setup 50.15

o Suppaorted

o Supported

o Supparted

Directory accessability

Dir/File Requiremen t Currant Status
JfRuntime «f Writable o Writable
Jdata < Writable «f Writable
JApplication/Instail/Data o Writable «F Writable

JAppiication/Common/Cont/config.php « Writable o Writable

T I
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Add your company name, this text will be shown in BigAnt messenger title line.

Please enter your Email, then click Next button

BigAnt Server Setup 5015

Select DB ENV Test e Create DB Setup Complete
Company Information

Company Name

Email

Initializing
Just wait a minute while installing database and initializing data.

BigAnt Server Setup 50.14

Welcome ENV Test Create DB e Setup Complete

+ Begin to install database...

+ Create data tablesoauth_client...Succeed

+ Create data tablesoauth_token...Succeed

+ Create data tablessys_admin..Succeed

+ Create data tablessys_app...Succeed

+ Create data tablessys_app_addin...Succeed
+ Create data tablessys_config..Succeed

+ Create data tablessys_db_backup..Succeed
+ Create data tablessys saas..Succeed

+ Create data tablessys saas_server...Succeed
+ Create data tablessys_server..Succeed

+ Create data tablessys_server_relation..Succeed
+ Create data tablessys_time_task..Succeed
+ Create data tablessys_validcode...Succeed
+ Initializing

+ Initializing data succeed

< Installing

BigAnt Server Setup is completed
Now you’ve finished the setup. You may click ‘OK’ button to open the BigAnt Admin-
istration, or double click the icon of BigAnt Console on the desktop to open BigAnt

Administration after you close the current browser in the future.

In case of using MySQL database, please refer to the following screenshot:

Following please find screenshot for settings in case of using MySQL database
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BigAnt Server Setup 50.15

Select DB ENV Test e Create DB Setup Complete
Company Information

Company Name

Email

Database Information

Database Type | MySal hd
Database Server | 127.0.0.1 Database Server IP, default 127.0.0
Database Port | 3307 Database Server Port, default 3307

Database Account | root
Database Password ssesasessReRES

Database Name | antdbms

In case of using SQL database please find following instructions:
To make sure your connection to SQL Server works, you may need to download and

install the msodbcsqgl_64.msi to your machine.

BigAnt Server Setup

Select DB e ENV Test Create DB Setup Complete

It is needed to install msodbcsql_64.msi if you choose SQL Server database, otherwise the connection to sql
server may be error. Click to download and install

ENV Test
curl_init Function «7 Supported
Idap_connect Function «/ Supported
______ [ . I

Create your company (for SQL Server Database)
Complete your company information: Company name and the contact Email.

Enter your Database password.
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Database Information

Database Type  SQlServer v
Database Server | 127.0.0.1 Database Server IP, default 127.0.0.1
Database Port 1433 Database Server Port, default 1433
Database Account | @
Database Password

Database Name  antdbms

Enable firewall /trust services

When you finish BigAnt server installation, there should be following programs added to
your server, please trust them in your firewall and enable ports 8000/8001, 6091~6099,
so that messenger program can work properly.

C:\Program Files (x86)\BigAntSoft\IM Console\im_server\antGo\proxy\antzoo.exe

T AT T S ———
+ Computer » Local Disk (C:) » Program Files (x86) » BigAntSoft » IM Console » im_server » antGo » proxy

ew Tools Help

Include in library = Share with = Burn Mew folder
Mame Date modified Type Size
[ antzoo.exe 1/6/2020 2:54 AM Application 13,942 KB

C:\Program Files (x86)\BigAntSoft\IM Console\im_server\antGo\antbiz.exe
T AT TR T T —_——

» Computer » Local Disk (C:) » Program Files (x86) » BigAntSoft » IM Console » im_server » antGo »

View Tools Help

Open Burn Mew folder

Mame Date modified Type Size
] . conf 3/20/2020 4:21 AM  File folder
rads J log 3/20/2020 4:21 AM  File folder
Places |\ proxy 3/20/2020 4:21 AM  File folder
||E] antbiz.exe 1/8/2020 1:05 AM Application 18,290 KB

C:\Program Files (x86)\BigAntSoft\IM Console\im_server\server\
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=) » Program Files (x86) » BigAntSoft » IM Console » irm_server » server »

are with + Burn Mew folder

Mame Date modified Type . Size

. conf 8/5/201910:24 PM File folder

J leg 8/5/201910:31 PM File folder

| proxy 8/5/201910:24 PM File folder
B TestDll.exe 11/24/2019 9:43 PM Application 38 KB
m- UpApiServer.exe 1/8/20201:42 AM Application 1,306 KB
B UpFileServer.exe 1/8/2020 1:40 AR Application TI3 KB
B UpGroupServer.exe 1/8/2020 1:40 AR Application 1,181 KB
B UpLoginServer.exe 1/8/2020 1:40 AR Application 880 KB
B UpMessageServer.exe 1/8/2020 1:40 AR Application 1,255 KB
B UpOrgServer.exe 1/8/2020 1:43 AM Application 2,618 KB
B UpPushServer.exe 1/8/2020 1:40 AR Application 853 KB
,.,' UpRelayServer.exe 11/24/20199:43 PM  Application 709 KB
B-1 UpStatusServer.exe 1/8/2020 1:40 AR Application 1,075 KB
B UnWatchdoaSeryer.exe 1/8/2020 1:38 AM Application 506 KB

Launch BigAnt server console

When installation is done, a BigAnt Console shortcut is created on the desktop. Double

click it to see the following screen:

BigAnt Admin

.

y SuperAdmin

Default account: SuperAdmin, password: 123456. Please update password before set

this server for production.
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After your login, you will see the BigAnt messenger administration console.

In the right pane of home page, there are portals of user/department management,
client program downloading links, and server information like IP address, and service
management button. Kindly note, the server IP address shown here may not keep
updated and may be incorrect if your server runs virtual machines or has multiple

network cards. A static LAN/WAN IP is required for BigAnt server, so that the client

program can connect with it.

BigAnt Administration Welcome, Super Admin

> )
Welcome:Super Admin (The free space of your hard disk Is: 336.61 G}

User Management I m Client Installation |

3 Add, delete, edit, import/export users and departments. Download Instructions for PC/Android/iFhone/Mac

Registration details Server Info

Company Name:test] Register Type:N Service number:8 Server IP: 192.168.43.222

Uecansed Usern:S0 Expiry Date:2015 Default ports:

24 5097, 000, 80
[ Gecere [
-

Click on “Service Console” button lower right in Administration Console, you will be able
to check all BigAnt services running in this machine, start/restart them, and IP/Ports of

this machine.

Service console

You will be asked to enter service admin password, which is again 123456 as default.
Then you will see all settings can be made to this BigAnt server. If the status of all
services is shown as green check with text “running”, then your BigAnt server is on good
condition.

You may leave everything as default, unless you need to have your client login from

internet, if you have subsidiaries or users work at home, please read on.
Access BigAnt from Internet

Please go to BigAnt Administration>service console, the button lower right in the screen,

Please login as ServiceAdmin and then go to “system settings>Server Mapping Config”
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BigAnt Service Console Welcome,ServiceAdmin +

B Service List >

erver Mapping Config

System Settings Installation Files E-mail Settings SMS Settingﬁ’l Server Mapping Config | Center Server Config

«” API Protocol

Web service host http://192.168.91.122:8002

File service hast http://192.168.92.122:8001

Connection between server/client

then scroll to the part “Server Mappings” and click “Add a server mapping” in the
bottom to add your BigAnt server WAN IP address, for instance 111.11.111.111, see

following screenshot for an example:

':onnection between server/client |

E)efault AN IP or WAN Delete this server mapping

Server type

Login Server Address 192.168.1.122 eg. 192.168.0.1

Web service http://192.168.1.122:8000 eg. http://192.168.0

&

192.168.1.122:6097 eg. 192.168.0.1:609

Logfn Server Address 11111111111 eg. 192.168.0.1

Server type WAN IP TN Delete this server mapping

Web service hght

T11.11.111.111:8000 eg. http://192.168.0

&

File servicg host 111.11.111.111:6097 eg. 192.168.0.1:6097

Add a server mapping

And, you may need to setup server mappings on router, depends on your external network
connection methods:
Optionl: BigAnt server is directly connected to WAN/Internet
If your company has a static IP, then BigAnt clients should use this IP or domain as
network settings.
Or, if your company is using ADSL dial-up, then DDNS, dynamic domain name (e.g.,
peanut shell) is required, your staff can log in BigAnt through the dynamic domain
name.

Option2: BigAnt server is connected to LAN/local network.
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Port mapping is required, please set port 6090 to be mapped to BigAnt server, and

ensure firewall on both router and server are enabled for all required ports.
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Admin accounts

When you are login BigAnt server console, click on the pull down menu near account
field, you will find “system administrator, security administrator, audit administrator,
super administrator, security administrator” to login, each administrator role has dif-
ferent view/accessibility of server console:

All administration accounts are NOT case sensitive, default password: 123456

superadmin

System Admin
Security Admin
Audit Admin

Super Admin

Super Admin:

Account: SuperAdmin

Available functions: Console Home | Users | System Settings | System Tools | App
Add-ins | Database management | Security Control | Server Logs

Following please find the screenshot for “super admin”

BigAnt Administration Welcome, Super Admin ¥

# Console Home

Welcome:Super Admin (The free space of your hard disk is: 336.61 G)

& Users > ‘
L System Settings ? User Management \ ' Client Installation |
1l System Tools 3 Add, delete, edit, import/export users and departments. ' Download instructions for PC/Android/iPhone/Mac

22 App Add-ins >

3 Database management >

& security Control >
Add User Add Dept. PC Client MAC Client iPhone Client Android Client
.l Server Logs >
Registration details Server Info
Company Name:test] Register Type:Number of users Service number:8 Server IP: 192.168.43.222
Licensed Users:50 Expiry Date:2019-06-24 Default ports: 6091-6097, 8000, 8001
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System Admin:

Account: admin

Available functions: Console Home | Users | System Settings | System Tools | App

Add-ins | Database management

Please Note: “Roles and permissions” is part of Security Control, which is managed by

Super Admin and Security Admin, not for System Admin.

Security Admin:

Account: security

Available functions: Security Control

Audit Admin:

Account: auditor

Available functions: System Logs

Service Console Admin:

Account: ServiceAdmin

Available functions: Check/change/start and stop BigAnt services, ports, configure

LAN/WAN IP addresses for this server machine

Please find the service console entry button lower right in Admonition Console.

BigAnt Administration

# Console Home

& Users >

8 System Settings D User Management
(W) System Tools >

&8 App Add-ins >

13 Database management > .+

48} Security Control >

Add User
wll Server Logs >

Registration details

Company Name:Acompany4test

Licensed Users:50

Add, delete, edit, import/export users and departments.

Register Type:Number of users
Expiry Date:2019-06-25

> .
Welcome:Super Admin (The free space of your hard disk is: 334.02 G}

A

PC Client

Server Info

Welcome, Super Admin~ [ ¥

% Client Installation
' Download ins

e & http://localhost:8002/index.php/Ms/index/index/clientid

& Home page | BigAnt

[ mag

& Agfiinistrator Accounts >

it System Settings >

Service List

ange message

Brief Settings
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Manage User accounts

No matter if your company organization is a small team with dozens of members, or
your enterprise is with branches, offices and subsidiaries, BigAnt messenger can show

contacts in a clear structure.

Create departments
Please go to Administration >Users >User management page
e Click on your company in left pane in the structure list, and click the menu

button Add Dept. to create departments

Welcome, Super Admin ¥

BigAnt Administration

# Console Home >
User Management /mytest
8 Users >
Add Dept. Dept. Settingsw Add User User Settingsw Import and Exports Add Member
¥ User Management
test i
b User List B mytes Eoain . :
Accounts (] Account Name Gender Mobile Email Status
» Groups

} Grant
¥ Nameplates

} Account Approval

£} System Settings >
1 System Tools >
22 App Management >

e If necessary, you can create a sub department in similar ways. Just choose an
existing department, and click the menu button Add Dept. to create a sub
department.

e You can right click on a department and add department to it.

¢ To modifying department information, choose a department, and click "Dept.

Settings/Edit department”, as shown in the following screenshot:

BigAnt Administration

#& Console Home >
User Management /testone/DevTeam
ﬁ Users >
Add Dept. Dept. Settings» | Add User | User Settingsw Import and Exports Set default avatar
¥ User Management =
Edit Department
¥ User List E|“; testony Move Department Login
sale Sort Account Name Gender
Set an expiration on members
» Groups Dey
» Sub-Admin Delete Department
} Role lcons
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You can modify the department name, sort/sequence number, and detailed information.
The sort/sequence number is to adjust index sequence of this department shown in

contact list.

Add user accounts

When your company organization/departments are created, you can then add user

accounts to the departments.

e Choose a Department (which will be highlighted), and click the menu button Add User
to create user accounts.

e Edit user information, the "basic information” and "login information" should be
composed by the administrator, and leave "more information" for users themselves.
¢ Check "Super administrator” if you want him/her login BigAnt server console manage

BigAnt system on behalf of you.
e The status button allows you to disable/enable user account when this user is
quit/back.

e Please note: user account must be unique and should not be duplicated.

New User

Basic Information More Information Login Contro Permissions
Name Gender ﬂ

Account

Status

Password
Enable W

Job Title
Mobile
Phone

Email

Cancel

e Please note: by default, there are four system administrator accounts, with which

accounts you can login server console and manage this system. Please edit those
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accounts and update password before production to protect your IM system privacy.

¢ In “login control”, you can set limits for the clients’ login locations and devices, with
range of IP address and Mac address. You can use wildcard * for IP address like
192.168.0.*, and minus sign for IP rage between 192.168.0.1-192.168.0.100, or IP

addresses separate with comma like 192.168.0.8,192.168.0.9

MNew User

Basic Information More Information Login Control

IP range : 192.168.0.1-192.168.0.10

IP match : 192.168.0.*

Multiple IP : 192.168.0.6,192.168.0.16

Splice multiple conditions by commas : 192.168.0.1-192.168.0.10,192.168.0.6

Allowed login IP

User Settings: User Settings allow you to edit user properties, assign departments and
delete user account. Also, with user move out button, you can move selected users out
of current department, then assign them to other department. And you can delete users

so that they won’t be able to login again.

BigAnt Administration
>

# Console Home

User Management jtestone/salesDept.

& Users >
Add Dept. Dept. Settingsw Add User User Settings» Import and Exporte Set default avatar
P User Management X
Assign dept.
test
P User List = sstons Remove from the dept. .
salesDept. | Name Gender Mobile En
DevTeam
b Groups Delete User Peites
» Sub-Admin
O 10000 AlexC Alex Clever
P Role lcons
O System Settings >
10 rows/page
Il System Tools >

Import and export users

You can import users from AD/LDAP, or, import users from previously saved file, which

is with a specified format
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Import User Accounts from Active Directory
The BigAnt Server Console has the Active Directory Import Wizard that allows you to
import user accounts from the Active Directory (LDAP) catalog by Organizational Units.

It is easy to create a user database in a few minutes if your corporate network is based

on the Windows Domain structure.

BigAnt Administration

#& Console Home >
User Management ftestone
& Users >
Add Dept. Dept. Settings~ Add User User Settings~ Import and Export- Set default avatar
¥ User Management
Import Users
test
¥ User List = esans Import Dept. . B
salesDept. O Sort Gender Mohile Email
Import part of users
b s DevTeam
P Sub-Admin Bxport User
Export Dept.
» Role lcons
L System Settings >

Click import domain user and enter details of your domain server to import users.
From the pop up window, please enter your Domain server name, your domain admin
account and password. Then click OK to import domain users, this may take a few

moments to process.

For example:
Domain server--=> [MyDomain]
Admin Account-->[Administrator]

Password--=>[****]

Import Domain User

Domain Server
Admin Account

Password

Note:

Your BigAnt server has to connect to the same domain network as the domain needs to

be imported.
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Your DNS IP must be the same as your domain server IP address.

Please enter domain server name instead of server IP address for the field Domain

Server.
After the AD has been successfully imported, it will look as the following (My TestAD in
this case.)

Hello, admin Home

BigAnt Console

SR A e Organization Management

Organization

All Users Add Dept Dept Settings ~ Add User User Settings « Import and Export = Er
All Roles
Department management Member List
Permissions Eﬁ Organization Account MName Gender Email
- MyTest Co.
Groups =N
? = : No data
E-8 American Divison
Tags Marketing
RD

System Tools

Sales

Asian Divison
Marketing
RD

: Sales

CED

Extended Features

Query & Statistics

Ant Documents

Live Support

e Using Active Directory to authenticate user account: Check this option if you use

Active Directory to import user accounts.

BigAnt Administration
>

A Console Home

Passwaord Validation

Users
w O Enable System Validation
X} System Settings > O Enable Domain (LDAP) Validation

® Enable Domain(AD) Validation

P System Settings
P Extensions Settings

P Password Validation

For more instructions on importing users, check following online help:

https://www.bigantsoft.com/support/server/Users_Manage-Add_users_in_created_de

pt.html


https://www.bigantsoft.com/support/server/Users_Manage-Add_users_in_created_dept.html
https://www.bigantsoft.com/support/server/Users_Manage-Add_users_in_created_dept.html
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Import User Accounts from a file

Prepare the file to import users

Either the file is exported from your database or is typed in, it should be modified to
match the request format of the import file.

Note, please make sure there is no duplicated user accounts in the file, because the
system won’t check it and will cause problem if there are duplicated accounts.

(You may find a template file from BigAnt Administration > Import and Export > Import

Users = Import from File > View template of users import > download)

Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat Team
L8 - fe |

A B C D E F G H

2 |BigAnt Soft/Marketing 1000 Amy Amy Hellawell |2 Sale amy_hellawell@bi
3 |BigAnt Soft/Marketing 1000 Amy Amy Hellawell |2 Sale amy_hellawell@bi
4 | BigAnt Soft/Marketing 1000 Daniel Daniel Sanchez |1 Sale daniel_sanchez@b
6 |BigAnt Soft/Development|1000 Emily Emily Bradley |2 Engineer emily_bradley @bi

For more instructions on how to import users from a file, please find online instructions

from following link:

https://www.bigantsoft.com/support/server/how_to_import_users_from_a_file.aspx

A complete “User List”

If you need to list all user accounts of BigAnt messenger on server, please go to “BigAnt
Administration >Users>User list”, this page shows all users in a plane table, not in a
structured view, this allows you to swiftly check/change/add/remove user accounts,
batch processing in this page is useful and very efficient.

Please note, if you created users from this User List page, the system won’t aware which

department they are belongs to, if the users are created as root OU users, they are hide
to be shown on any other users. please remember to assign a department, or at least
your company to this user, to prevent this problem. Please see following screen shot on

how to assign department to a user.


https://www.bigantsoft.com/support/server/how_to_import_users_from_a_file.aspx
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BigAnt Administration

# Console Home » .
User List
% Users >
Mew User Batch Operationw
» User Management
I Set Department I
b User List U A
Delete User
» Groups 0
andre
P Grant
I Jjessica

» Nameplates

Create Groups/Teams/Discussions

This function allows you to create a discussion group. There are three type of groups in
BigAnt messenger: Team/Group/Discussion, Team is the most official and Discussion is
the most informal, team must be created and managed by an administrator, while group
and discussion can be created by anyone.

Please go to page: BigAnt Administration> Users > Groups-->Teams -->Enter
Team/group name and write description

Welcome, Super Admi

BigAnt Administration

# Conscle Home

W Users >
* Teams: Created on Console, Client cannot add members
P User Management * Groups: Created on Client, Group Admin can invite and delete members
* Discussions: Created on Client, Group Member can invite users but cannot delete Group Members

Groups

P User List
» Groups Groups Teams Discussions
P Grant
New Teams Delete Teams Group Sea
P Nameplates
Type Name Note Creator Date Created
P Account Approval O yp
Teams Team A Super Admin  2018-05-02 15:41:37  Member | Edit | Delete
¥ System Settings > O E
New Teams

Name Team Al X I

Note

Group Size 1000

Close Save
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Then select members to be added into the group.

User Management-->Groups-->Add Group-->Members

Then select members.

In this case, Peter and Sara are in Groupl.Now the group has been successfully created

and users in Groupl can start a group discussion.

r

Select user
Member  ou
[user]Peter - Search Member

[user]Sara Michael

E.. ou
E| MyTest Co.
Marketing
: - Sales
: E| Finance

L Sara Michael
IT Support

4

Here is a look from the client end.

= MyTest Co.
r &4

| P Edit what | do

) Bl
Bulletin Search contacts
ﬁ Groups Discussions -+
MNao Bulletin

Team A

Group Members (2/2) Q

ﬁ Peter

Sara Michael

A©O -9 @ (® History

Close Send ¥

Eo x4
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Assign Sub-admins

There are multiple ways to add user accounts, by Super Admin, or by leaders who knows
their members better, you may want to assign Sub-admins so that they can login BigAnt
console add accounts for their users.

Please go to Administration>Users>Sub-admins to select users who can do this on

behalf of you/System Admin.

BigAnt Administration

4 Console Home >

Sub-Admin
& Users >
¥ User Management
b User List [ User Department Authorized users Creator

O Lisa Newa Jtestone/salesDept. 0 Super

» Groups Admin

¥ Sub-Admin

¥ Role lcons Total 1 Records 10 rows/page

Please enter user name and then select the department for him to manage, then you’ve

assigned this user as Sub-Admin of this department.

Mew Levels

User Lisa Newa

Authorized dept. festone

E% ou
E15 taerons

In this case, Lisa is in charge of the whole company “testone”

BigAnt Administration

# Console Home > .
Sub-Admin
& Users >
Assign Sub-admin Delete Sub-admin
¥ User Management
b User List O User Department Authorized users Creator 1
i tests o] S

b Groups ID Lisa Newa Jtestone I A:':i;

¥ Sub-Admin

» Role Icons Total 1 Records 10 rows/page

Role icons is a small icon that can be shown near to a contact, looks like a badge or a
rank/insignia, different badges help people visualize contact’s job title etc.
e Please go to page: BigAnt Administration> Users > Badges to add and manage them.

¢ Please mind the size of picture that used as a tag, it should be 22*9 pixels.
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e When an icon is created, you can click “member” button to manage who have this

badge. When you run BigAnt client program, you will see those contacts are with this

icon near to their name.

BigAnt Administration
>

# Console Home

Role Icons
8 Users >

Add

» User Management

Icon Name

P User List
fd Leader

b Groups [ = |

¥ Sub-Admin N

¥ Role lcons o 10 rows/page

System Settings

This is to setup the profile of whole BigAnt messenger system, the changes of settings
here will apply to all users and may require IM server restart to take effect.

Please mind to click “save” button when you made changes.

BigAnt Administration Welcome, Super Admin »

# C le H > .
onsels foms System Settings
E Users >
Server Settings
L8 System Settings >
[ Auto-clear message/files Change [MRecord login logs [¥]Enable multi-devices online concurrently
[JEnable OU permission management [JEnable mobile devices validation [JServer Mapping (coming soon)
» System Extensions
» Password Validation Client Settings
> e et []Disable changing password on client [JEnable P2P transfer on client, Threshold(M) [Audio and remote access are relayed by server
0
1l System Tools 2 []Disable group sharing files [1Disable audio chat []Disable video chat
22 App Add-ins > [Disable sorting order by online status

[WMessage transferring encrypted AES256 ﬂ [JEnable security level (It is recommended to enable

the friend verification function at the same time)
#1 Notahara mansnamant 3

System extensions

This is for the settings of client customizations, please leave it as default.

BigAnt Administration Webcome, Super Admin *

A Consale Home

System Lxtensions

W Users ¥
Client extension Sorvir exlension Weh extension
R System Settings E
Add Settings | Delete Settings
¥ System Setting
b System Extensions [] Category Name Value Note
¥ Pasvword Validation client_ext access_token ADZDFACA-F129-FEDA-6TAF Edit | De
BS70205240R3
b 0% Push
client_ext AVserverPort 11027 ppsenver port Cdit | Delete
* Datn Push

W System Tools »
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Password Validation

Here you have three options:

Enable system validation means BigAnt database stores user accounts and passwords
(encrypted in database, not readable texts in database), and BigAnt system validates
users’ credentials

Enable Domain (LDAP/AD) Validation means BigAnt won’t validate client’s password,
however it redirects the credentials to your domain server to get validated, please check
this option if users accounts are imported from LDAP/AD, and you wish them to login

with same password for BigAnt and domain.

BigAnt Administration
>

# Console Home

Password Validation
% Users >

O Enable System Validation
O Enable Domain (LDAP) Validation
able Domain(AD) Validation

O System Settings >

P System Settings

‘ Save
P System Extensions
¥ Password Validation

» i0S Push

IOS push

This is for the iOS client to receive messages from BigAnt server system.

BigAnt Administration Welcome, Super Admin ¥
>

# Console Home

iOS Push
&8 Users
10S JPush
€& System Settings >
b System Settings Application ID
¥ System Extensions Certificate documents Upload Certificate documents
} Password Validation
Key file Upload Key file

-

i0S Push

Data Push Import push certificate

-
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System tools

Here you have tools to maintain BigAnt system automatically, to update client program

version or schedule sync tasks.

Install updates

This option is for BigAnt Server Administrator to keep BigAnt Messenger Client versions
up-to-date without having to manually install the software on users' computers, the
update package can be pushed to client computers.

Please download the latest version of UpdateAnt.zip(client packages) from our website
or contact us at info@bigantsoft.com. This zip file contains latest version of BigAnt client
install “IMUpdate.exe” and an version initial file “client.ini”, please extract and make a
copy of the IMUpdate.exe file and rename it similar as “updateclient_v_5.5.50.exe”, if
5.5.50 is for instance, please replace it with a real version number, which must be in-
cluded in the .exe file name, because it won't process the update if the client computer
is already running the same or later version of client program. The push program is
checking update package version from the .exe file name and the .ini details.

The client.ini is a text file with following lines:

[Info]

Ver=5.5.50

Force=1

Please launch server Administration console, go to “system tools/update” then click on
“new update package”

Please browse and select the client update packages, both .zip and .exe are required.
Please login your BigAnt client, after a few minutes while the update package down-
loading from server side, then you will have a pop-up window says “updating”.

And, the push of client update is for the minor version updates, major updates like 5.0

update to 5.2 still requires fresh re-install on client computers, manually.


mailto:info@bigantsoft.com
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BigAnt Administration Welcome, Super Admin ¥
>

#C le H
necieriome Install updates
# Users >
Windows Client Mac Client Linux Client Android mobile terminal
8 System Settings >
New de Packa
1) system Tools > v upgrade Fackage
P Install updates Default Default File Date
Name Version ion(Zip) | llation(Exe) File Path Size Created
P Themes
updateclient v_5.2.53.exe  5.2.53 4 [webserver]/data/FC353817-C018-A1EC-  85.65MB  2019- Edit | Delete
¥ Task Scheduler CE3B-DBBA989BFBA3/admin/2019-04- 04-29
29/updateclient_v_5.2.53.exe 16:27:56
28 App Add-ins >
updateclient5.2.53 5253 d [webserver]/data/FC953817-C018-A1EC-  8545MB  2019- Edit | Delete
13 Database management > CE3B-DBBA989BFBA3/admin/2019-04- 04-29
29/updateclient5.2.53.zip 15:38:36
& security Control >
.all Server Logs >

When the client detects the new version, it will prompt following update notes:

MNew version available, click OK to
update...

OK

Then it will download the upgrade package, and process the program install.
Note: The client update won’t prompt to chat window, it only pushes to clients when

they log in to the program.

Task Scheduler

(was Timer Manager) This is to sync your AD/LDAP with BigAnt database in a routine
task, especially to maintain BigAnt user list.
When you import users from AD/LDAP, and selected “Set automated import user” then

you will find a scheduled task to visit/process the target URL, shown as following screen:

‘Welcome, Super Admin ¥

BigAnt Administration

# Console Hom .
oo Timer Manage

& Users >
Add Timer
G System Settings >
Task name Task period Target url Date Created Status
W System Tools
Synel 1440 minute Wtp:/flocalho mport/start/ssid/B24241A0-4C56 2018-03-07 11:07:26 ] Edit | Delete
P Install updates 2626-AED9-T rht

» Themes

¥ Timer Manage
B8 App Management >
13 Database management >
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App Add-ins

(was “Application Management”) BigAnt messenger is flexible of showing or hide some
icons such as “bulletin” or “cloud disk” for client program, and you can expect future
more add-ins for BigAnt program.

Add-ins

Click on this tab and you will find available add-ins for BigAnt client

BigAnt Administration
>

# Console Home

Applications
u Users > e e
£ System Settings ? o .' ))
W) System Tools >
Cloud Disk Bulletin
28 App Management >

» Applications

b My Application

Selected Add-ins

(Was “My Applications™) Here list all selected add-ins, and you can manage users/roles

who can access this add-in.

Select Role

[] everyone [[] custom service

Database Management

This page allows you to check with BigAnt database status, back up database tables,

restore from earlier backups, and restore database to erase everything.
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Database backup

Here you have a list of database tables, and you can check the size of them, backup the

database in an easy way.

H H : Wel Super Admi
BigAnt Administration =icome, Super Admin ¥
# Console Home >
Database backup
* Users ?
) BackupTest1| X
£ System Settings > Backup the database
W System Tools » q
Table name Count of records Size of data Date created

&8 App Add-ins > ext_attach 0 16KB 2019-04-24 16:09:53
3 Database management > ext_blog 0 16KE 2019-04-24 16:09:53

» Database backup ext_board o 16KB 2019-04-24 16:09:53

> Oreroes meseme ext_board_attach 0 16KB 2019-04-24 16:0%:53

You will then go to BigAnt server installed directory and search the name of backuped

data, in this case BackupTestl, then have a copy of it in a safe place, or to a new server.

Database Restore

You can restore data base with earlier saved/backed up database tables.

Welcome, Super Admin *

BigAnt Administration

# Console Home

Database restore

ﬁ Users >
[1 Backup name File size Backup data location Backup users Date Created
L System Settings »
] BackupTest1_20190425- 17.69KB Jdata/FACIS209-AD4A-B049-16F3- Super Admin 2019-04-25
1) 5ystem Tools 5 114759.5ql.0z CGCF19BSEFO7/db/BackupTest]_20100425- 11:47:59 Delete
g 114759.5ql.gz
28 App Add-ins »

3 Database management >
} Database backup
¥ Database restore

} Database initialization

Database initialization

This is to restore your BigAnt database, click “Begin to initialize” will clear the organ-
izational units include departments and users, this action cannot undo and please think

twice before you do this.
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Security control

This allows you to add roles of users, enable users can and cannot, checkout user
login/logout status, query messages histories, etc.
Please make sure you are login the console as SuperAdmin, or SecurityAdmin, the Role

control portal won’t be shown to SystemAdmin or Admin

Role management

BigAnt messenger is well designed on Roles and Permissions/user security levels, which
controls user accessibility on contacts and departments, for example:

Scenery 1: Each branch in your company are running separately, and requires no users
from both branches can see and chat each other.

Scenery 2: You have an army like company, you want your sergeant see relevant sec-
tions only, while higher rank commander can see whole company, and private can see
contacts of their own section.

Scenery 3: Some of users are subcontractors and they are limit of sending files and

access remote desktop, Limit of sending group messages, etc.

Follows please find how to do that.

Please go to BigAnt Administration> Security Control> Roles, you will find a default role
called “everyone”, without assigning to a specified role, every user in BigAnt messenger
are public and won’t hide to each other.

Now click button “New Role”, to create a role, name it and then click “Permissions” to set
allows/disallows for this Role, click “member” to assign people to this role, click “Access
control” to give a range of users/departments for the people of this role to chat with.

Repeat these steps and create all roles for your company.
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Welcome, Super Admin ¥

BigAnt Administration

# Console Home

Roles
E Users >
MNew Role Delete Role Search Role
O System Settings >
Name Note Creator Date Created Status

1 System Tools > a

- O everyone Security 2019-04-24 16:09:53 Enable  Edit | Delete

B8 App Add-ins > Admin

13 Database management > O custom service Security 2019-04-24 16:09:53  Enable  Edit | Delete
Admin

* Security Control >

¥ Roles

Total 2R

10 rows/page
¥ Security level

} Login Logs

When the settings are done, please mind to enable OU permission in system settings to

switch on this functionality.

BigAnt Administration

# Console Home

W Users >

System Settings

Server Settings
£ System Settings >

[~]Automatically clear messages and files(by 180 days) [“]Record login I¢

P System Settings . .
[“]Enable OU permission management [[JEnable mohile

» Extensions Settings
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Examples of Roles settings

For example, if you want the users in financial dept. can only see members of their own

dept., please create a new role, called “role2-ou permission” in this case.

L Roles Management

Organization

All Users Add Role Edit User List Delete Role
All Roles
Name Description Disabled
Permissions
eryone Default Add Edit Delete
Groups
rolel-file sending the maximum file size can be sent is Add Edit Delete
Tags limit 5000kb
System Tools role2-ou users of financial dept can only see Add Edit Delete
permission members of t

Extended Features

Click “member” button to select and assign the users/department for this role, and click

“Access control” button to limit users who are visible to this role.

£

New Role
Search contacts
matior Member f N Access Control 3
=] ou "~ Finance 2/2
= MyTest Co. Peter

Marketing Sara Michael
Sales
IT Support

Click “save” when settings done,
mind to switch on system settings

“OU permission”

Client view >
Then you may go to client end and verify the result, login as one of Finance department

user and see on their own department members listed as contacts.

Another example, you can switch on/off permissions for a specific role, say limit some of
them can send file size no more than 5MB, see screenshot on how to do this:

Add a roll called “Rolel - file”
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New Role

Basic Information Member Permissions Access Control

Name Role1 - file
Note the maximum file size can be sent is 5000kb
Status Enable ~

And then go to “Permissions” to modify the maximum size of file sending as “5MB”, you

can set it as “-1” to disallow file sending of any size.

New Role
Basic Information Member Permissions Access Control
Allow to edit
[1Gender/Birth []Position Edit
[IWhat | do [JAvatar

Show information

[IMobile []Telephone
[JEmail [JRoom#

Messaging limits

[]Disable file sending []Disable voice chat
[ |Disable video chat [ |Disable remote access

Miscellaneous

File size limit for sending (Max 8192 MB) 5
Limit of recipents on batch message {(Max 1000) 1000

Restrion on file transfer: Upload KB

Close Save

Then, you can click “Member” to select users who need to be limited for file sending, in

this case, Sara
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New Role
Basic Information Member Permissions Access Contro
Member m ou
[user]Sara Michael 2 Search Member

= ou
=] MyTest Co.
Marketing
Sales
[=] Finance
! Sara Michael
IT Support

A full list of role permissions

Following functions can be setup for the roles.

Disable changing personal properties ( e.g. company decent and policy)

Disable receiving attachment (e.g. to prevent running an unsafe file sent from other
users)

Disable audio call (e.g. to save band width)

Disable logging off client (e.g. to force users stay online)

Disable notification sound on client (e.g. to mute the program on behalf of users)
Disable sending protected message (a protected message requires log-in password to
read. E.g.to avoid pry actions when you leave your seat. Disable it if you think this
feature is not required and may confuse users)

Disable changing avatar on client (e.g. company decent and policy)

Disable showing organization chart (hide organization chart to some of users, e.g.
subcontractors)

Group send limits (to limit amount of recipients say maximum 5 users, e.g. avoid abuse
use of group sending message to the whole company)

Disable changing job title (e.g. company decent and policy)

Disable exiting client (users can not Kill this program, however user log out is allowed)
Disable remote desktop and control (ie.to take it as exclusive authority of IT specialist)

Disable sending nudge (If you think nudge is annoying, and want to disallow in your
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group)

Disable showing working signature ( e.g. company decent and policy)

Disable screen capture ( e.g. company decent and policy, or may be security concerns)
Disable setting status as "Away"(e.g. company decent and policy)

Disable creating group (If you think them should not create group chat, they can only
added by admin, or someone else who is not limited of this function)

Please note, portal for following item is changed in version 5.2:

Allow sending/deleting bulletin message ( e.g. only manager level users or HR can send
bulletin message) Please go to Administration>=App Add-ins (was: App management)
Selected Add-ins>Bulletin Console, in the left pane click “Permissions” to add roles who

can send bulletin messages.

Security levels

Security level means user accessibility are divided by authority levels, higher level users
can send messages to a low level people, while a lower level cannot send messages to
the high level. The authority of level is downward decrease (level 1 > level 2 > level 3).
By default, there are 3 levels, you can add more if needed.

Click “User” to assign members to this level and this gives you a quick way to make
supervisor invisible to the rest of members, and he can still talk to any one for an in-

terview.

Welcome, Super Admin *

BigAnt Administration

A Console Home

Security level management

ﬁ Users >
Level Description Member Status Operation
£ System Settings >
1Level 0 Enable User | Edit | Disable |
1l System Tools > Delete
28 App Add-ins y | 2evel 0 Enable User | Edit | Disable |
Delete
13 Database management > 3Level 0 Enable User | Edit | Disable |
Delete

ﬁ Security Control >

} Roles + Add a security level

} Login Logs

Please mind to go to “BigAnt Administration>System Settings: Client settings, check the
option “Enable security levels” to enable this function. This option is lower right in the

screen.
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System Logs

(was “Audit management”)
The BigAnt messenger server console keep a record for users and administrator login,

user login etc.

You may click on the pulldown menu to narrow down type of records.

BigAnt Administration LA

# Console Home

Logs
# Users >

--ALL-- (W Please enter key words

L8 System Settings >

Obj Type Obj Op Obj ID Obj Name User Date Created
1l System Tools

Account Log in 4 Super Admin Super 2019-04-25 12:17:39
28 App Add-ins > Admin
£} Database management >
8 security Control » Total 1 Records 10 rows/page
wall Server Logs >

P Logs

Service Console

This is to maintain BigAnt system and to keep it running at health status.
Please find the service console portal button bottom right side in BigAnt administration

console, see screenshot:

BigAnt Administration Welcome, Super Admin ~1

A C le H: > .
enseleHome Welcome:Super Admin (The free space of your hard disk is: 329.28 G)

& Users > ‘

CAG RS s ? User Management \ . Client Installation

1l System Tools > Add, delete, edit, import/export users and departments. 4 Download instructions for PC/Android/iPhone/Mac
22 App Add-ins >

rd
43 Database management > 2; '... e .

& security Control >
[ pcclient | [ macdlient | [ iPhoneclient | [ ar

.l Server Logs >

Registration details Server Info
Company Name:testone Register Type:Number of users \ Service number:8 Server IP: 192.168.31.122
Licensed Users:50 Expiry Date:2019-06-24

Default ports: 6091-6097, 8000, 8001

Please login with ServiceAdmin and then you will have service console:
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BigAnt Service Console Welcome,ServiceAdmin
>

B senvice List
«” API Protocol >
& Administrator Accounts >

£F System Settings >

&)

Home page

Service List

Add/Change messag

Administrator Accounts

Manage Admin Accounts

Brief Settings

e service, push service etc.

Interface Server Address: http://127.0.0.1:6099
File service host: http://192.168.31.122:8001

Service List

BigAnt messenger runs 10 services and 8 of them are listed here in the Service Console,

please ensure they are running in both Service Console and your server task manager.

Please try to add trust to the BigAnt server program, enable firewall and reboot server,

and start the services from task manager, press pull down buttons of Sync Webserv-

er/IMserver from top right in your screen.

The 2 services not listed here is UpAntBiz and UpAntZoo, which provide organization

chat/contact list for client end program, if you are difficult of loading BigAnt contacts

then there must be something wrong with these 2 services.

Follows please find the services should be running in your computer control panel:

1% Windows Task Manager — _—— il . C=
File QOptiocns Yiew Help
| Applications | Processes | SEMVICES | Performance I Metworking | Users |
-~
T FID Description Status Group
UpAntBizServer 11... UpAntBizServer Running M/fA
UpAntZooServer 11... UpAntZooServer Rurning  M/fA
UpApiServer 10...  UpApiServer Rurning  M/fA
UpDBEServer 3160  UpDBServer Rurning  M/fA
|IpFileServer 11... UpFileServer Rurning  M/fA
UpGroupServer 12... UpGroupServer Rurning M/fA
UpLoginServer 11... UploginServer Running M/fA
UpMessageServer 6644 UpMessageServer Running  M/fA
upnphost IUPnP Device Host Stopped  LocalSerwvic...
UpQrgServer 9952  UpOrgServer Rurning  M/fA
IpPushServer 12...  UpPushServer Rurning  M/fA
UPSecurityInputService 2592  UPSecurityInputService Rurning  M/fA
UpStatusServer 12... UpStatusServer Rurning  M/fA
UpwWatchDogServer 10... UpwatchDogServer Rurning M/fA
pWebServer 9364 UpWebServer Running M/fA
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And the service listed in BigAnt Service Console:

BigAnt Service Console Welcoms ServiceAdmin

el service List ’ Server New Server

«” API Protocol >

& Administrator Accounts > P Start B Stop ~Select ﬂ Search Server

& System Settings > [ Service Name Service Type ServerlP ServerLAN IP Status
O LOGIN_192.168.21.122 Legin Service 192.168.31.122:6091 127.0.0.1:6091 @ Running Edit | Delete | Stress

Balance
O STATUS 192.168.21.122 Status Service 192.168.31.122:6092 127.0.0.1:6092 @ Running Edit | Delete
O ORG_192.168.31.122 OU Service 192.168.31.122:6093 127.0.0.1:6093 @ Running Edit | Delete
O MESSAGE_192.168.31.122 Message Service 192.168.31.122:6094 127.0.0.1:6094 @ Running Edit | Delete
O GROUP_192.168.31.122 Group Service 192.168.31.122:6095 127.0.0.1:6095 @ Running Edit | Delete
O PUSH _192.168.31.122 Push Service 192.168.31.122:6096 127.0.0.1:6096 @ Running Edit | Delete
O FILE_192.168.31.122 File Service 192.168.31.122:6097 127.0.0.1:6097 @ Running Edit | Delete
INTERFACE_192.168.31.122  Interface Service 192.168.31.122:6099 127.0.0.1:6099 @ Running Edit | Delete

API Protocol

BigAnt messenger server is designed to work as open platform, with APl protocol a
customized program/client program can work with BigAnt services through command
lines.

Access management

This is to add/remove the customized client program.

BigAnt Service Console Welcome, serviceAdmin v
>

Service List
~ Access Management

«” APl Protocol >
New Client Search Client
b Access Management
» Token Management [] Client Name Client ID Client Key Description Creator Date Created Status

Token management
This is to list token of customized program, check with status of them and clear expired

token if necessary.

Administrator Accounts

This page allows you to add/remove more administrator accounts to manage this

service console.
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System settings

This is to modify your BigAnt server, especially server IP/Ports for the internet access.
Server Console Address:

Web service host is for the webserver console, setup this correctly so that you can
launch and manage your BigAnt server online at anywhere.

File service host is for the files access by server console.

Connection between server/client:

Server type: please choose either LAN or WAN for this server mapping settings.

Login Server Address: this is for the BigAnt client login IP address

Web service host: this is for the web services like bulletin and listing contacts in client.
Please check this IP is correct and make sure port 8000 is available for BigAnt server.

File service host: this is for the files sending/receiving, default port 6097

If your clients need to login from internet, please click “Add a server mapping” to setup

internet WAN IP server host.

BigAnt Service Console Welcome,ServiceAdmin ¥
>

5 Service List Server Mapping Config

System Settings nstallation Files E-mail Settings SMS Settings Server Mapping Config Center Server Config

& System Settings > Server Address

«” AP| Protacol >

& Administrator Accounts >

Web service host http://192.168.33.122:8000

File service host http://192.168.33.122:8001

Connection between server/client

Server type Default v
Login Server Address 192.168.31.122
Web service host http://192.168.31.122:8000

File service host 192.168.1.122:6097
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Client Installation Files

This tab is to update BigAnt client installation files ready for download from your

webserver.

BigAnt Service Console Wikcome,servicendmin v

L service List 3 .
it System Settings
«” APl Protoco >
System Seftings Installation Files E-mall Settings SMS Settings Server Mapping Config Center Server Config
& Administrator Accounts
£ System Settings ¥ Fon Winchows Itpe192.168.31.1 22:8002 data/ms/2019-04- 26, - Browse...
Far Mac Browse...
Far 105 Browse,..
For Androld Browse...
Save Settings

This is for the update of the links in the following Administration Console Home page, the

BigAnt client download button redirect clicks to the file that you added.

Wirlcame, Super Admin =

BigAnt Administration

W Conzole Home ¥ 5
Welcome:Super Admin (the free space af your hard disk i 335.31 G)

.‘ Users ¥ ‘ ‘
€ System Sottings * User Management Client Installation

%
1B Systom Tools 3 Add, dulute, edit, importfexport wsers and departments. # Dowmioad instructions for PC/Android/iPhone/Mac
88 App Add-ine &

8. N, - £
13 Database mansgement : .-q»- E . 1 [}

- | Ay
B secunity Cantral 3

Add User Add Depr. | PC Clent o MAC Client Phane Client Android Client |

wall Server Logs 2

Registration details Server Info
Company Nama:Ac 4 Ragister T of users Sarvice number:3 Server IP: 192.168.31.122
Licensed Users:50 Explry Date:2019-06-25 Default ports: 6091-£097, 3000, 8001

You can share this URL with your team members/employees/users, so that they can

download and install client program as instructed.
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Trouble Shooting

Please find error codes and corresponding fix to the problems

Error getting full data...
Phenomena: BigAnt client shows “error getting full data...”, or it keeps “loading data”
This error happens when you start BigAnt client, the log-in goes well however it prompts
“Error getting full data...” or it keeps loading data..., the contact list in BigAnt client is

blank while it trying to load.

K

Search contacts

-
»

Loading data, pleae wait...

Error getting full data, please quit
program and login again, if
problem insists please contact
admin or program developer for
more help

oK =

Most possible reason (a):

You are running BigAnt client version 5.5 however the server is still earlier version,

which are incompatible.

Not sure what version you are running? Please go to server console and click “about”

button in top right drag down menu, to find version information.

Solution: Please run a compatible version of BigAnt client and server program.
5.5version program: https://www.bigantsoft.com/download/bigantim55.zip
5.2version program: https://www.bigantsoft.com/download/bigantim52.zip
5.0version program: https://www.bigantsoft.com/download/bigantim5.zip

Kindly please note: 5.5 version server is incompatible with earlier version client, vice versa.


https://www.bigantsoft.com/download/bigantim55.zip
https://www.bigantsoft.com/download/bigantim52.zip
https://www.bigantsoft.com/download/bigantim5.zip

e S
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More possible reasons (b):
Your BigAnt server IP is changed, and it is mismatched with server IP/Port settings.
Solution: Please go to Service console>System settings>Server Mapping

config=Connection between server/client> Web service host, check the IP is current in

use on your server.

BigAnt Service Console Welcome,Serviceadmin ]

[ service List > Karver Mapping Config

«” API Protocol

System Settings  Installation Files  E-mail Settings ~ SMS Setting Center Server Config

Server Mapping Config

Web service host hittp://192.168.31.122:8000

File service host http://192.168.

Connection between server/client

Server type Default ﬂ LAN IP or WAN IP Delete this server mapping

LogiMgerver Address 192.168.31.122

Web service host http://192.168.31.122:8000 eg. http://192.168.0.1:8000

File service host 192.168.31.122:6097 eg. 192.168.0.1:6097

More possible reasons (c):

The services UpAntBiz and UpAntZoo are missing or stopped on BigAnt server.
Solution: Please make sure your server is on good condition, the services especially
UpAntBizServer and UpAntZooServer are running, please check with your server’s task

manager as following screen:

.- 5
1% Windows Task Manager - - - - albe
File Options View Help
| Applications | Processes | SErvices | performance | Metworking | Lsers |
-~
MName PID Description Status Group
UpAntBizServer 11... UpAntBizServer Rurning M/A
UpAntZooServer 11... UpAntZooServer Running  MN/A
UpApiServer 10... UpApiServer Running  MN/A
UpDEServer 8160  UpDBServer Running  MN/A
|IpFileServer 11... UpFileServer Rurning M/fA
UpGroupServer 12... UpGroupServer Rurning M/A

If the services are not there, please download and install latest 5.5 version BigAnt
server to fix it.

5.5version program: https://www.bigantsoft.com/download/bigantim55.zip


https://www.bigantsoft.com/download/bigantim55.zip
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Server access failure

Phenomena: BigAnt client shows “Server access failure” when it starts up.

BigA

LisaC

EkEkEEE

ERemember my password

M Sign in automatically

Sign In

£} Network

This error happens when BigAnt client program unable to
connect with BigAnt server.
Possible reason and fix:

® The server IP address is incorrect, please click on the
button “Network” lower right in client program to check with
server IP and port are correctly entered.

® The server firewall blocks BigAnt services, please try
to run BigAnt client on the same machine installed with BigAnt
server console. If BigAnt client program works fine on server

machine however won’t able to work elsewhere, then there

must be something with your server firewall, please try to close/disable firewall to

confirm this. Afterward you will need to add BigAnt program be trusted on firewall,

and enable ports, by default port 8000,8001,8002, and port 6660~6669, or

6090~6099, go through firewall and your network router. Please enable/add pro-

gram “UpLoginServer.exe” to be trusted in firewall as following screenshot:

Allow programs to communicate through Windows Firewall

To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing a program to communicate? Change settings

Allowed programs and features:

Mame

Home/Work (Private)]  Public *

PL-Sharo
UplLoginServer.exe

UPSecuritylnput
UPSecuritylnput

[#] Visual Basic Command Line Compiler
[ Visual Basic Command Line Compiler

VMware Authd Service (private)

ViMware Workstation Server (private)
[OwWeb Management Service (HTTP)

¥l WeChat

O Windows Collaboration Computer Name Registration Service
¥ Windows Communication Foundation

HOROKEDORORE X
NOEOOO0OEOEOEO

[ Details... ” Remove ]

[ Allow another program...

Please read more about “Enable firewall /trust services”

® Or, it may be caused of the services are stopped. If this is the case, BigAnt client
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having this problem even you run it on the server computer. Please check with your
server status on both service console and task manager, please read more about

“Service list”
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